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Technical Support
PowerSuite Professional technical support is only available to 
registered PowerSuite Professional users, therefore complete your 
registration online at http://uk.megger.com/support/after-sales-
support/software-registration/ or complete your registration card 
and return it to the support department as soon as possible:

Megger Limited 
Archcliffe Road 
Dover  
Kent CT17 9EN

PowerSuite Professional technical support is available in the  
following ways:

T +44 (0)1304 502 106 (Mon- Thur, 08:00 to 17:00, 
  Fri - 08.00 to 16:00)
F +44 (0)1304 502 303
E powersuite@megger.com

Before contacting technical support, please refer to written 
documentation and online help. Please be near your computer if 
possible and be prepared to provide the following information:

1. The first six characters of your registration number, eg. PSDEMO. 
(Available from the ‘About’ option on the main ‘Help’ menu.)

2. Software version number, also available from the ‘About’ screen.

3. Any relevant error messages and codes.

4. The steps taken and operations performed leading up to the 
problem.

Recommended System Requirements

 ■ Microsoft Windows™ XP operating system, (Windows 7 
compatible) 

Recommended System Requirements (Mobile Device)

 ■ Windows Mobile 5 or 6

 ■ Symbian S60 V3



Installation – Stage 1

N.B. Please close all Windows programs before installing, 
as any running programs may stop critical files from being 
installed correctly and result in an incomplete installation.

If the CD does not auto run when inserted, you will have to 
manually run the Setup.exe program from your CD-ROM drive. 
(e.g. “D:\Setup.exe”).  

Follow the installation prompts and accept the default values where 
possible.

Registration

During the installation you will be prompted to enter your name, 
company name and the 16-digit registration number from the 
registration card included with the software.

The next screen will prompt you to complete your Ultra Mobile 
registration number if applicable.

N.B. Please complete and return your registration card to 
Megger Technical Services as soon as possible to receive 
telephone support and software updates. Alternatively, you 
can register your software online at: 
http://uk.megger.com/support/after-sales-support/software-
registration/

The registration number should 
be entered in one string with no 
spaces or dashes. To help identify 
numbers they will be underlined 
on the registration card. Your 
registration number will be 
validated on the second stage of 
the installation  procedure.



Installation – Stage 2

The second stage of the installation will install ‘Megger Download 
Manager’ onto your machine. It is recommended you select all the 
default options for the Download Manager installation.

The Download Manager program will run automatically once it has 
been installed and you will be presented with a list of supported 
test instruments to install.

 

When you close the Download Manager program, the remaining 
installation steps will be carried out.

 

Running PowerSuite Professional

To start Megger PowerSuite Professional:

1.  From the windows Start menu 	    .    
Select PowerSuite Professional from the Programs|PowerSuite 
Professional group. 

 

Type ‘Supervisor’ in the ‘User ID’ field on the Login screen and click 
the ‘Start’ button to run the software.

Select the test instruments 
you currently use and click 
the ‘Add Driver’ button 
to install the driver(s) into 
Download Manager. (Hold 
down the ‘Ctrl’ key and 
click to select more than 
one instrument).

Once the ‘Installation 
Completed’ message has been 
displayed at the bottom of the 
install screen it will disappear 
and you can run the software.



Setup Wizard

The first time that you run the software, the Setup Wizard will  

guide you through creating your own  company contact. 

 
The Setup Wizard will also prompt you to enter details of personnel 
and set up lists of test instrument serial numbers.

 

(Personnel and instrument serial numbers will be available as drop 
down lists when editing certificates).

You can add and amend the personnel and test instrument lists 
using the ‘List Editor’ program that is available from the ‘Programs’ 
menu in the PowerSuite shell.

Once the Setup Wizard has been completed, you can continue with 
Basic Operation sections for either Appliance testing or BS7671.

Basic Operation: Appliance testing  and BS7671 

PowerSuite Professional works in conjunction with the Megger 
PAT4/400 Series test instruments to produce portable appliance 
testing certificates in a variety of styles.



Program Flow

The recommended operating procedure is as follows:

1. Run the Contact Wizard to set up your clients and locations.

2. Select Locations you wish to send (Upload) to the PAT4/400 
Series.

3. Upload to the PAT4/400 Series*. 

4. Test appliances storing the results then return to the computer.

5. Run the Download Wizard to transfer the data from the 
PAT4/400 Series into PowerSuite.

6. Assign the Data to its relevant Location. (If you have a database 
version of the software).

7. Run the Certificate Wizard to create a certificate and select the 
results Datablock you wish to use.

* N.B. The Upload process will erase all data already existing 
on the PAT4 and PAT400 Series. If you are already using 
a PAT4/400 Series you will need to download it first using 
the Download Wizard before you commence with the 
recommended operation procedure.

Contact Wizard  

The PAT4/PAT400 contains a one-to-many relationships between   

 Client and  Location contacts.  

Click the  ‘Contact Wizard’ button to set up new Client and 
Location contacts in PowerSuite. 

    

Follow the screen prompts ensuring that you first select to add a 
‘CLIENT’ contact. Once the ‘CLIENT’ contact has been added you 
will be prompted to add ‘LOCATION’ contacts against it. 

Ensure that each client is added to the Contact tree under your   

 ‘COMPANY’ contact.



Upload to the PAT4 

Before you upload ensure you have the correct cable attached 
between the PC and the PAT4 .

Select Locations

This step involves dragging the Locations you require uploaded to 
the PAT4 driver in the Download Manager window.

To select a Location to upload:

	  
1. Click on the  ‘Location icon’ next to the Location name.

2. Drag the icon over the ‘MEGGER PAT4’ name in the Download 
Manager window.

3. Release the mouse button.

4. Click ‘Continue’ on the data selection screen.

5. An ‘Upload Me’ file will be created in the PAT4 ‘Inbox’.

Click once on the  item in the Download 

Manager window, and then click the small    ‘Upload’ button 
on the toolbar.

  



Select the ‘Upload Me’ file to upload and click the ‘Open’ button. 
When the ‘MEGGER PAT4 Upload’ screen is displayed follow the 
prompts by selecting ‘Comms’ on the PAT4 followed by ‘Receive’ to 
start the upload.

* N.B. The Upload process will erase all data already existing 
on the PAT4. You will receive a confirmation message on the 
PAT4 before the data is erased.

Upload to PAT400 MK1   

Before you upload ensure you have the correct cable attached 
between the PC and the PAT400.

Select Locations

This step involves dragging the Locations you require uploaded to 
the PAT400 driver in the Download Manager window.

To select a Location to upload:

1. Click on the  ‘Location icon’ next to the Location name.

2. Drag the icon over the ‘MEGGER PAT400 MK1’ name in the 
Download Manager window.

3. Release the mouse button.    

4. Click ‘Continue’ on the data selection screen.

5. An ‘Upload Me’ file will be created in the PAT400 ‘Inbox’.

	  
Click once on the  item in the Download 
Manager window, and then click the small  ‘upload’ button on 
the toolbar.

You will then see a window that asks you “what .csv file” you wish 
to upload to the tester.



Select the “UploadMe” 
file and click open to 
upload the desired 
csv file to the Megger 
PAT400 tester. 

	  
You will then see an Upload screen. To create the DB file press the 
“Upload” button in the bottom right hand corner. 

	  Browse to the drive letter that corresponds to your memory stick. 

Then in the ‘File name’ field, delete the star *. Type in a name for 
the database file and press ’Open’.  

	  
You will then see another screen flash up to confirm that the 
database has been created on your drive. 

Select the “UploadMe” 
file and click open to 
upload the desired 
csv file to the Megger 
PAT400 tester. 



You will see this window 
pop up as the .DB file is 
created. 

To upload the file to your Megger PAT400 Series tester safely, 
eject the USB stick from your PC and plug the USB stick into The 
MEGGER PAT400 Series tester.

Select the ‘Data’ menu using the arrow keys. Then select the 
‘Restore from USB’ option using the arrow keys on the Megger 
PAT400. Press ‘OK’. Then select the ‘File name’ from the down list 
using the arrow keys and press ‘OK’.

Downloading from PAT4 ‘Download Wizard’  

The Download Wizard will transfer the test results from the PAT4 
and create a new file in the PAT4 ‘Inbox’ in the Download Manager 
window. Before you download, ensure you have the correct cable 
attached between the PC and the PAT4.

Click the  ‘Download Wizard’ button and follow the prompts 
to display the ‘MEGGER PAT4 Download’ screen. Once this screen 
is displayed select ‘Comms’ on the PAT4 followed by ‘Send’ to start 
the download.   

  

A new download file will be created in the ‘MEGGER PAT4’ ‘Inbox’. 
The date and time stamp will be used as the file name.

After the download from a MEGGER PAT4 ONLY has finished 
the Wizard will ask if you would like to create contacts from a 
MEGGER PAT4 Download File.  If you select ‘Yes’ you can select 
which Clients/Locations you would like to create. Select these and 
click ‘Next’.  The Contact tree will be updated and new Clients and 
Locations inserted in alphabetical order.



When you click ‘Next’ you will see a list of all the available 
download files. This list will include files in the ‘Inbox’ and the 
‘Kept’ folder for the specified instrument.

   

When the download file has been selected, the required conduit file 
will be loaded and the data will be processed. Once the database 
has been updated a new unassigned contact will be created 
containing the assets and test results. Click the ‘Finish’ button to 
end the Format Wizard. Once the unassigned data has been created 
the next step is to link or ‘Assign’ it to a contact or contacts. 
Once the data has been assigned the unassigned reference will 
be removed and the data will be available as a data block for the 
creation of certificates.

When you click on ‘Finish’ the ‘Assign tab’, will be active and the 
formatted files will be ready to Assign. 

Downloading from PAT400 MK1 ‘Download Wizard’   

First plug a USB stick into the Megger PAT400 tester.

On the Megger PAT400 tester, select the ‘Data’ menu using the 
arrow keys then select ‘backup to USB’ and press ‘OK’. 

Enter a file name and click ‘OK’.  

Unplug the USB stick from your PAT400 Tester and plug the USB 
stick into your PC.

On the PC, open PowerSuite and click the ‘Download Wizard‘ 

button .  
You will then be prompted 
to select the tester. Select the 
‘Megger PAT400 MK1’ and press 
the ‘Next’ button.  



You will then see the download screen appear as follows:   

  
	  Click the ‘Connect’ button and you will see a new window appear. 

You will then see a download screen that shows what drive you are 
connected to. Select the ‘DB file’ you require and press ‘OK’.

	  

Click on the Client drop down 
list and select the name of the 
Client you wish to download 
data for.

To download you must make a 
selection from the drop down 
menu, and then press the 
‘Download’ button. 

	  

Once you have selected the 
Client and Location data as 
described in the previous step, 
you will see the Download 
Wizard complete screen.  
Click ‘Next’ on this screen to 
continue.



Pairing the MFT1700 Series to your device

Turn the instrument on and select the ‘SETUP’(spanner) position on 
the small rotary switch.

Press the ‘Function’ (< - >) button repeatedly until the display 
shows the ‘bt’ menu (followed by the ‘bt’ on auxiliary display),

Press the right hand ‘TEST’ Button unit and select a blank pairing 
(displaying ‘- - -‘),

Press and hold the left hand ‘LOCK’ button until you see two 
flashing arrows alternating ‘<’ and ‘>’. 

Search on your PC or mobile device and enter the pass code 
provided when prompted.  The pass code is 1234. 

Downloading from MFT1700 Series

‘Download Wizard’    

Please make sure that you have paired your MFT1700 Series 
to your computer (as mentioned in previous steps) before you 
continue with the following guide.

On the PC, open PowerSuite and click the ‘Download Wizard’ 

button.   

	  

You will then be prompted 
to select the tester .Select 
the ‘Megger MFT 1700 
Series + MFT 1800 Series’ 
and press the ‘Next’ 
button.  

You will then see the download screen appear as follows:   

	  

Turn the ‘Small Dial’ on the 
MFT round to ‘SND’ and 
turn the ‘Large Dial’ to any 
available option, and then 
press the ‘Bluetooth’ button.

 



	  

You will then see the down-load 
window change to indicate which 
comport it is downloading and the 
‘Green Data’ box will flash 
showing that the PC is receiving 
data.  Once data is received the 
‘Download Wizard’ window will 
appear to show that downloading 
of the data has been completed. 

The download window above indicates that downloading of the 
data has been completed. Click ‘Next’ to continue. 

Certificate Wizard  

The Certificate Wizard is used to create new certificates and to 
import selected test results that you have downloaded from your 
tester. Before you create a new certificate, ensure that you highlight 
the correct location contact in the 

Contact tree by clicking on it.      
  

Click the   ‘Certificate Wizard’ button and select the style of 
certificate you require. You will then be prompted to select the 
‘Datablock File‘ to populate the certificate. 

You will be prompted with the next available certificate number 
and identity for this type of certificate. You can accept or override 
these.  You will also be prompted to automatically create an 
appointment for the appliances next test date.

The certificate will be loaded complete with all the test data 
selected. The certificate may have more than one page and you 
can easily switch between pages using the  page controls. 
Complete the certificate by filling in the rest of the details. The 
certificate can be printed at any time by clicking the 

‘Print’  button.



Editing Existing Certificates

To load an existing certificate, highlight the location contact and 
select the ‘Edit/View an Existing Certificate’ tab. 

Double click on the required certificate to load it back in where it 
can be reviewed, edited and re-printed.

Installing Ultra Mobile

With PowerSuite running, click the large ‘Mobile’ button   

on the PowerSuite toolbar to load the Ultra Mobile Module.

The ‘Mobile Device Installation Wizard’ should start automatically:

If the ‘Mobile Device Installation Wizard’ does not automatically 
start, select ‘Install Software on Mobile Device’ from the ‘Options’ 
menu.

The Mobile Device Installation Wizard will ask you to select the 
type of Mobile Device you intend to use.

Select the required device and click the ‘Next’ button.

The next screen will ask if this is a new installation on this mobile 
device or if you are updating the software on the device.

The default prompt will be for a new installation. Click the ‘Next’ 
button and then follow the instructions below for the type of 
device you are installing onto.

(Windows Mobile, Smartphone, Symbian S60 V3). If you select 
‘Windows Mobile’, ‘Smartphone’ or ‘Symbian S60 V3’ the 
following prompt will be displayed:

Ensure the Mobile Device is connected and Microsoft ActiveSync 
is running before clicking the ‘Next’ button to start the software 
installation.

The Ultra Mobile software will be installed on the Mobile Device. 
Once the software installation has completed, you will be 
prompted to check the mobile device screen.



N.B. The installation may take a few minutes.

You may be required to initiate the Ultra Mobile software 
installation on the device. Once the Ultra Mobile installation has 
completed, click the ‘OK’ button.

Once the software has been successfully installed you will be 
prompted to register a unique User ID with PowerSuite.

Click the ‘Next’ button to display a prompt screen with an entry 
field for a User ID.

The User ID you enter here is very important and the Ultra Mobile 
Module will use it to link specifically with the device you have 
installed the software onto. As it is possible to install the Ultra 
Mobile software onto multiple devices if you are licenced to do so, 
each user will have their own synchronising settings. The User ID 
could be entered to identify the specific mobile device or it could 
be the name of an engineer. Once you have entered your unique 
User ID click the ‘Next’ button.

You will be prompted to click the ‘Next’ button to register the 

user on the device. Once the user has been registered the following 
screen will be displayed:

Click the ‘Finish’ button and continue with Step 4.



There will also be a status of ‘Not Synced’ against the Last Sync 
Date. This status will be updated once you have uploaded your 
selected certificate templates in the next step.

You now need to synchronise with the device using the Ultra 
Mobile Module and upload the required certificate templates. 
The following template maintenance screen may be loaded 
automatically, otherwise click the  ‘Synchronise’ button 

on the ‘Ultra Mobile Module toolbar’. The following template 
maintenance screen should be displayed:

Scroll up and down the list to view all the available certificate 
templates. Double click on the required certificate template name 
to change the status from ‘No’ to ‘Yes’. Any templates with a 
status of ‘Yes’ will be uploaded to the Mobile Device. Click the 

  ‘OK’ button to close the template maintenance screen. 
The selected templates will be automatically uploaded to the 
device.

Ultra Mobile - Basic Operation

The Ultra Mobile software has been designed to be flexible in 
it’s operation. Certificates can be generated in PowerSuite and 
transferred to Ultra Mobile via local synchronisation, removable 
media or email.  New certificates can be created from scratch on 
your Mobile Device and transferred back to PowerSuite for final 
certification.

The following section assumes that you have already completed the 
necessary steps to set up your clients and locations in PowerSuite 
and you are familiar with the basic operation of creating new 
certificates.



Standard Operation – Synchronisation

Method 1

This method of operation involves a direct connection between PC 
and Mobile Device via a USB cable or cradle.

1.  (PC) Run the Certificate Wizard in PowerSuite to create a  new 
Installation Testing certificate for your selected location.            

First highlight the correct location in the contact tree and click the 
large ‘Certificate Wizard’ button . 

When you are prompted to select the type of certificate be sure 
to select ‘Installation Testing’. Complete the remaining wizard 
prompts, finally selecting the certificate number, then click the 
‘Finish’ button to create the certificate and display it on screen.

You can part complete any data fields on the certificate before 
closing it and returning to the ‘Certificate Manager’ screen.

2.  (PC) Export the certificate to the Ultra Mobile Module.

To export the certificate you have created to the Ultra Mobile 
Module, first ensure you have the ‘Edit/View an Existing Certificate’ 
tab highlighted in the’ Certificate Manager’ in PowerSuite and 
you also have the correct location highlighted. ‘Right click’ on the 
certificate you wish to export to display a pop up menu.

Select the ‘Export Certificate to Mobile Device’ option from the 
pop up menu, and then select the ‘Device User Name’ from the 
next pop up menu.

Select ‘Yes’ to the confirmation prompt to upload to the Ultra 
Mobile Module.

N.B. Once the certificate has been exported from PowerSuite 
into the Ultra Mobile Module it will be locked and cannot be 
edited in PowerSuite.

3. (PC) Load the Ultra Mobile Module and check the certificate is in 
the Mobile ‘Outbox’ ready to be synchronised with the Mobile 
Device.

You can now load the Ultra Mobile Module by clicking the large 
‘Mobile’ button on the PowerSuite toolbar.   

Once the module has loaded, ensure the required User Name is 
selected from the drop down list, and click the ‘Outbox’ tab. 



You should see your certificate in the ‘Outbox’ ready to be 
synchronised with the Mobile Device.

4.  (PC) Ensure the device is connected to the PC via a USB cable or 
docking station and the Ultra Mobile program is NOTrunning.

5.  (PC) Synchronise from the Ultra Mobile Module to transfer the 
certificate to Ultra Mobile.

Click the ‘Synchronise’ button on the Ultra Mobile Module toolbar 
 and the certificate will be transferred from the Ultra Mobile 

      Module ‘Outbox’ to Ultra Mobile. Once the certificate has been 
transferred you can close the Ultra Mobile Module. 

N.B. Pressing ‘F5’ will refresh the ‘Outbox’, this is necessary 
if the Ultra Mobile Module is open when a certificate is 
exported from PowerSuite.

6. (Mobile Device) Run the Ultra Mobile program on the device and 
load and edit the certificate as required.

 To start the Ultra Mobile program on a Windows Mobile 
PDA, open the ‘Programs’ folder and click the ‘Ultra Mobile’ icon. 

To start the Ultra Mobile program on a Windows Mobile 5 
SmartPhone, click the ‘Ultra Mobile’ icon from the ‘Start’ menu.  

     
    



To start the Ultra Mobile program on a Symbian S60 device, open 
the ‘Installations’ folder from the main Symbian start screen and 
click the ‘Ultra Mobile’ icon.

The Ultra Mobile welcome screen will be displayed for 2 seconds 
and you can click or tap the screen to load the program. (You can 
switch off the welcome screen from the ‘Preferences’ menu)

Like PowerSuite, the Ultra Mobile software has a simple to use built 
in Certificate Manager. The Certificate Manager defaults to the 
‘Open Certificate’ screen but can easily be switched from the ‘File 
menu’ to create new certificates.

The certificate you exported from PowerSuite will be displayed and 
you can highlight it and click or tap on the certificate name to load 
it.

The certificate pages will be loaded and the first page of the 
certificate will be displayed ready for editing. The top two rows 
show the current page and section.

You can move between pages in three ways. Clicking on the 
current page name will show a drop down list selection of the 
available pages in the certificate.                              

Tap or click on the page you wish to load. You can also tap or click 
on the ‘Options menu’ at the bottom right of the screen and select 
‘Select Page…’. Alternatively you can use the ‘LEFT’ and ‘RIGHT’ 
navigation controls on your mobile device to move between pages.



All pages are split up into sections where possible to help make 
data entry easier. The program defaults to showing the first section 
when loading the page, however, this can be changed to default 
to: (All Sections) in the preferences. 

 

      

You can move between sections on a page in three ways. Clicking 
or tapping on the current section name will show a drop down 
selection of the available sections on the page. Tap or click on 
the section you wish to load. You will also have the option of 
displaying (All Sections) on the page. You can also tap or click on 
the ‘Options menu’ at the bottom right of the screen and select 
‘Select Section…’. Alternatively if you use the ‘UP’ and ‘Down’ 
navigation controls on your mobile device you will see the section 
change automatically as you navigate beyond the last/first field in 
the section.

The main area of the screen is divided into a two-column grid with 
labels in the left hand column and space for entering data in the 
right hand column. 

You can enter data by clicking in one of the fields in the right 
hand column and using one of the available input methods on 
the mobile device to enter text. Some of the data entry fields will 
contain drop down lists. 

If a field has a list available you will see a small drop down arrow 
at the right hand edge when the field is being edited. Tapping or 
clicking on this arrow will display the drop down list in the grid. 
You can scroll up and down the list and tap or click to make a 
selection. You can also see the drop down list full screen by clicking 
the button when the field is being edited. 



The current selected list item will be highlighted and you can scroll 
up and down and tap or click to select an item from the list. If 
you select the ‘Back’ option from the menu, the list selection will 
be cancelled and you will be returned to the grid. You also have 
the option of entering data manually for these fields if you do not 
want to select an item from the list.

Some fields are defined as date input fields. If you click on one of 
these types of fields a date selector will be displayed. 

Once you have selected the required date tap or click on the ‘OK’ 
menu option to return to the certificate entry screen.

Some fields allow you to enter more than one line of text. When 
you click on one of these multi-line input fields a ‘Multi-line text’ 
input screen will be displayed. 

Once you have entered all the text in a multi-line input field tap 
or click on the ‘OK’ menu option to return to the certificate entry 
screen.

Once you have finished editing the certificate, select the ‘Close 
Certificate’ option from the ‘File menu’ to return to the Certificate 
Manager screen.

7. (Mobile Device) Mark the certificate as completed in the Ultra 
Mobile software.

You can continue to edit and make changes to the certificate as 
required. Once you have finished editing and wish to transfer the 
certificate back to PowerSuite you will need to alter the status of 
the certificate in the Ultra Mobile Certificate Manager.



      

The ‘Status’ column in the certificate manager has three states for 
each certificate, <Blank> (work in progress),< ‘Sync’> (ready for 
synchronisation), and< ‘Export’> (transfer to removable media or 
email). Tap or click on this status column to set it to ‘Sync’, and 
ready for transferring back to PowerSuite.

Close the Ultra Mobile software by selecting ‘Exit’ from the ‘File’ 
menu in the Certificate Manager.

8. (PC) Ensure the Mobile Device is connected to the PC via a USB 
cable or docking station ready to be synchronised.

Load the Ultra Mobile Module by clicking the large ‘Mobile’ button 
on the PowerSuite toolbar .

Ensure that the required ‘User Name’ is selected from the drop 
down list, and select the ‘Inbox’. Click the ‘Synchronise’ button on 
the Ultra Mobile Module toolbar.

The certificate will be transferred from the Mobile Device back into 
the ‘Inbox’ in the Ultra Mobile Module.

The certificate is now ready to be imported back into PowerSuite.

9. (PC) Import the certificate back into PowerSuite from the Ultra 
Mobile Module.

Click on the ‘Transfer Certificate’ button  and the certificate 
will be moved from the Ultra Mobile Module back to the correct 
location in PowerSuite.



Close the Ultra Mobile Module and press the ‘F5’ button to refresh 
the PowerSuite Certificate Manager. The original certificate will be 
unlocked and can be edited and printed as required.

Method 2

This method describes a new certificate being generated on the 
Mobile Device.

1. (Mobile Device) Run the Ultra Mobile software on the Mobile 
Device and create a new certificate from one of the available 
templates.    

With this method of operation the first step is to create a new 
Installation Testing certificate on the Mobile Device by selecting 
one of the available templates:

To start the Ultra Mobile program on a Windows Mobile PDA, 
open the ‘Programs folder’ and click the ‘Ultra Mobile’ icon. 

To start the Ultra Mobile program on a Windows Mobile 5 
SmartPhone, click the ‘Ultra Mobile’ icon from the Start menu.

To start the Ultra Mobile program on a Symbian S60 device, open 
the ‘Installations’ folder from the main Symbian start screen and 
click the ‘Ultra Mobile’ icon.

The Ultra Mobile welcome screen will be displayed for 2 seconds 
and you can click or tap the screen to load the program. (You can 
switch off the welcome screen from the ‘Preferences menu’).

Like PowerSuite, the Ultra Mobile software has a simple to use built 
in Certificate Manager. The Certificate Manager defaults to the 
‘Open Certificate’ screen but can easily be switched from the ‘File 
menu’ to create new certificates.

Select the ‘New Certificate…’ option from the ‘File menu’. A list of 
the available certificate templates will be displayed. Tap or click on 
the required template to create and load a new certificate.



The certificate pages will be loaded and the first page of the 
certificate will be displayed ready for editing.

2. (Mobile Device) Edit the new certificate in the Ultra Mobile 
software.

Refer to steps 6, 7 and 8 in Basic Operation Method 1 for 
information on editing, marking the certificate as completed and 
synchronising with PowerSuite.

3. (PC) Import the certificate back into PowerSuite from the Ultra 
Mobile Module.

Click on the ‘Transfer Certificate’ button  and the certificate 
will be moved from the Ultra Mobile Module to the ‘(Mobile Device 
Unassigned)’ contact in PowerSuite.

4. (PC) Move the certificate from the ‘Mobile Device Unassigned’ 
contact to the correct PowerSuite location.

Close the Ultra Mobile Module and press the ‘F5’ button to refresh 
the PowerSuite Certificate Manager.    

The ‘(Mobile Device)’ contact is automatically created under the 
‘(Unassigned Certificates)’ at the top of the Contact tree and this 
is a temporary storage location for certificates and data that is not 
tagged to a specific location. 

You can move the certificate from the ‘(Mobile Device)’ contact 
by dragging it over the required location in the Contact tree and 
releasing the mouse. You can then finish editing and printing the 
certificate.
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